Outlook 2002 Keyboard Shortcuts
General
F1

Display the Assistant balloon (if the Assistant is turned off. F1 opens the Help window)

ALT+ the letter underlined in an option Select an option in a dialog box. select or clear a check box in a dialog box
ALT+A

Switch to the Answer Wizard tab

ALT+C

Switch to the Contents tab in Help

ALT+C

In the Calendar. Accept a Meeting request

ALT+D

In the Calendar. Decline a Meeting request

ALT+DOWN ARROW

In Help. Display more Help topics in the Assistant list

ALT+DOWN ARROW

Open a selected drop-down list in a dialog box

ALT+EQUAL SIGN
ALT+F4
ALT+HYPHEN SIGN
ALT+I

Switch to months in the Calendar view
Close the selected program window. if this is the only open window. closes the program
Switch to weeks in the Calendar view
In Help. switch to the Index tab

ALT+LEFT ARROW

In Help. go to the previous Help topic

ALT+LEFT ARROW

Move selected item to the previous day when multiple days appear

ALT+number

Select a Help topic from the list the Assistant displays. ALT+1 is the first topic. ALT+2 is the second.
and so on.

ALT+O

Display the Options menu to access any Help toolbar (toolbar: A bar with buttons and options that you
use to carry out commands. To display a toolbar. use the Customize dialog box (point to Toolbars on
the View menu and click Customize). To see more buttons. click Toolbar Options at the end of the
toolbar.) command.

ALT+O

Display the Format menu

ALT+O. and then press B

Display the previously viewed topic

ALT+O. and then press F

Display the next topic in a previously displayed sequence of topics

ALT+O. and then press H

Return to the specified home page

ALT+O. and then press I

Open the Internet Options dialog box for Microsoft Internet Explorer. where you can change
accessibility settings

ALT+O. and then press P

Print all topics in a book or a selected topic only

ALT+O. and then press R

Refresh the topic (useful if you have linked to a Web page)

ALT+O. and then press S

Stop the Help window from opening a Help topic (useful if you want to stop a Web page from
downloading)

ALT+O. and then press T

Hide or show the pane with the Contents. Answer Wizard. and Index tabs

ALT+P

Print a print preview

ALT+PAGE DOWN

In the Calendar. go to the last day of the month in Date Navigation

ALT+PAGE UP

In the Calendar. go to the first day of the month in Date Navigation

ALT+PRINT SCREEN

Copy a picture of the selected window to the Clipboard

ALT+RIGHT ARROW

Go to the next Help topic

ALT+RIGHT ARROW

Move selected item to the next day when multiple days appear

ALT+S

Save and Close. Send

ALT+S or ALT+U

Print preview page setup

ALT+SHIFT+TAB

Switch to the previous window

ALT+SPACEBAR

Display the window shortcut menu (Control menu)

ALT+TAB

Switch to the next window

ALT+UP ARROW

Display previous Help topics in the Assistant list

ALT+UP ARROW

Go to the same day in the previous week

ALT+UP ARROW

Move selected item to the same day in the previous week

ALT+UP ARROW

Go to the same day in the previous week in Date Navigation

ALT+UP. DOWN. LEFT. or RIGHT
ARROW
ALT+Z

Move an appointment up. down. left. or right
Zoom in print preview
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Arrow keys
CTRL+U

Move between options in an open drop-down list. or between options in a group of options in a dialog
box
Underline selected text

CTRL+ COMMA

Next item (with item open)

CTRL+ SHIFT+S

Post to a folder

CTRL+[

Decrease font size

CTRL+]

Increase font size

CTRL+A

Select the entire Help topic

CTRL+A

Select all items in Table view

CTRL+B

Add bold to selected text

CTRL+C

Copy the selected items to the Clipboard

CTRL+INSERT

Copy the selected items to the Clipboard

CTRL+D

Delete

CTRL+DOWN ARROW

When a personalized menu is open. display the full set of commands

CTRL+DOWN ARROW

To the next address card

CTRL+E

Center

CTRL+END

To the last address card in the list

CTRL+END

Display (without selecting) the last item on the timeline (if items are not grouped) or the last item in the
group

CTRL+ENTER (Outlook e-mail editor
only)
CTRL+ESC

Send/post/invite all
Display the Start menu

CTRL+F

Forward

CTRL+F2

Open print preview

CTRL+F6

When more than one window is open. switch to the next window

CTRL+F7

When a document window is not maximized. performs the Move command (on the Control menu for
the window). Use the arrow keys to move the window. and. when finished. press ESC.

CTRL+F8

When a document window is not maximized. performs the Size command (on the Control menu for the
window). Use the arrow keys to resize the window. and. when finished. press ESC.

CTRL+F9

Minimize a window to an icon (works only for some Microsoft Office programs)

CTRL+HOME

To the first address card in the list

CTRL+HOME

Display (without selecting) the first item on the timeline (if items are not grouped) or the first item in the
group

CTRL+HOME or CTRL+END (with in-cell Move every item in the selection to the top or bottom in the list order in Table view
editing disabl
CTRL+I
CTRL+K (using the Outlook e-mail
editor)
CTRL+K (When using Word as e-mail
editor only)
CTRL+L

Add italics
Check names
Insert a hyperlink
Left align

CTRL+LEFT ARROW

Move one word to the left

CTRL+LEFT ARROW

To the closest address card in the previous column

CTRL+LEFT ARROW+SPACEBAR or
CTRL+RIGHT ARROW+SPACE

Select several nonadjacent items

CTRL+left mouse button

Edit a URL in the body of an item

CTRL+M or F5

Check for new mail

CTRL+N

Open a received message

CTRL+P

Print

CTRL+PAGE DOWN

To the first address card on the next page
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CTRL+PAGE UP
CTRL+PERIOD

To the first address card on the previous page
Previous item (with item open)

CTRL+Q

Mark as read

CTRL+R

Reply to a message

CTRL+RIGHT ARROW

Move one word to the right

CTRL+RIGHT ARROW

In Address Book. to the closest address card in the next column

CTRL+S or SHIFT+F12

Save

CTRL+SHIFT+A

Create an Appointment

CTRL+SHIFT+B

Display the Address Book

CTRL+SHIFT+C

Create a Contact

CTRL+SHIFT+D

Dial a contact

CTRL+SHIFT+DOWN ARROW

Extend the selection to the next address card. regardless of the starting point

CTRL+SHIFT+E

Create a Folder

CTRL+SHIFT+F

Use Advanced Find

CTRL+SHIFT+F6

Switch to the previous window

CTRL+SHIFT+G

Flag for follow-up

CTRL+SHIFT+H

Create a new Office document

CTRL+SHIFT+I

Switch to Inbox

CTRL+SHIFT+J

Create a Journal Entry

CTRL+SHIFT+K

Create a Task

CTRL+SHIFT+L

Create a Distribution List

CTRL+SHIFT+L

Add bullets

CTRL+SHIFT+LEFT ARROW

Select or unselect one word to the left

CTRL+SHIFT+M

Create a Message

CTRL+SHIFT+N

Create a Note

CTRL+SHIFT+O

Switch to Outbox

CTRL+SHIFT+O

Convert an HTML or RTF message to plain text

CTRL+SHIFT+Q

Create a Meeting request

CTRL+SHIFT+R

Reply all to a message

CTRL+SHIFT+RIGHT ARROW

Select or unselect one word to the right

CTRL+SHIFT+S

Create a Post in this folder

CTRL+SHIFT+T

Decrease indent

CTRL+SHIFT+TAB
CTRL+SHIFT+U
CTRL+SHIFT+UP ARROW

Switch to the previous tab in a dialog box
Create a Task Request
Extend the selection to the previous address card. regardless of the starting point

CTRL+SHIFT+V

Move item

CTRL+SHIFT+Y

Copy item

CTRL+SHIFT+Z or CTRL+SPACEBAR

Clear formatting

CTRL+SPACEBAR

Select or unselect the active item in Table view

CTRL+SPACEBAR

Select or unselect the active address card

CTRL+T

Increase indent

CTRL+TAB

Switch to the next tab

CTRL+TAB

Switch to the next tab in a dialog box

CTRL+TAB (with focus on the To line) Choose the account from which to send a message
and then TAB
CTRL+TAB or CTRL+SHIFT+TAB
CTRL+TAB or F6
CTRL+UP ARROW
CTRL+UP ARROW or CTRL+DOWN

When a toolbar is selected. select the next or previous toolbar
Move between Calendar. TaskPad. and the Folder List
To the previous address card
Go to the next or previous item without extending the selection in Table view
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ARROW
CTRL+V or SHIFT+INSERT

Paste

CTRL+X or SHIFT+DELETE

Cut

CTRL+Y
CTRL+Z or ALT+BACKSPACE
Display and use the Help window

Go to a different folder
Undo
To use the Help window. the Microsoft Office Assistant must be turned off. To turn off the Assistant.
press F1 to display the Assistant. Press ALT+O to open the Options tab in the Office Assistant dialog
box. Press ALT+U to clear the Use the Office Assistant check box. and then press ENTER. Press F1
to display the Help window.

DOWN ARROW

Select the next book or Help topic

DOWN ARROW

Select the next group

DOWN ARROW

Select the next block of time in Day view

DOWN ARROW

Select the next address card

DOWN ARROW

Move to the next line in a multi-line field

DOWN ARROW

Select the next group

DOWN ARROW or UP ARROW

When a menu or submenu is open. select the next or previous command

END

Move to the end of the entry

END

Select the last group

END

Select the time that ends your work day in Day view

END

Go to the last day of the week

END

Select the last address card in the list

END

Move to the end of a line

END

Select the last item on the timeline (if items are not grouped) or the last item in the group

END

Select the last group on the timeline

ENTER

Perform the action assigned to a default button in a dialog box

ENTER or LEFT ARROW

Collapse the group

ENTER or RIGHT ARROW

Expand the group

ESC

Close an Assistant message or a tip

ESC

Close an open menu. When a submenu is open. close only the submenu.

F1
F10 or ALT

Display the Help window if the Assistant is turned off. (If the Assistant is turned on. F1 displays the
Assistant balloon.)
Select the menu bar (menu bar: The horizontal bar below the title bar that contains the names of
menus. A menu bar can be the built-in menu bar or a custom menu bar.). or close an open menu and
submenu at the same time

F11

Enter a name in the Find a Contact box

F12

Save As

F2

Turn on editing in a field (except icon view)

F3 or CTRL+E
F4
F4 or ALT+I

Find items
Search for text in items
Open the Look in list

F5

Refresh the file list

F6

Switch between the Help topic and the Contents. Answer Wizard. Index pane (pane: A portion of the
document window bounded by and separated from other portions by vertical or horizontal bars. )

F6 or CTRL+SHIFT+TAB
F7

Switch between the Folder List and the main Outlook window
Check spelling

First letter of an option in a drop-down Open the list if it is closed and move to that option in the list of a dialog box
list
HOME

Move to the beginning of the entry

HOME

Select the first group

HOME

Select the time that begins your work day in Day view
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HOME

Go to the first day of the week

HOME

Select the first address card in the list

HOME

Move to the beginning of a line

HOME

Select the first item on the timeline (if items are not grouped) or the first item in the group

HOME

Select the first group on the timeline

HOME or END

Go to the beginning or end of a Help topic

HOME or END

Select the first or last command on the menu or submenu

LEFT ARROW

Go to the previous day

LEFT ARROW

Select the previous item

LEFT ARROW or RIGHT ARROW

Select the menu to the left or right. When a submenu is open. switch between the main menu and the
submenu.

LEFT ARROW or RIGHT ARROW

Move one character to the left or right

PAGE DOWN

Go to the item at the bottom of the screen in Table view

PAGE DOWN

Move to the end of a multi-line field

PAGE DOWN

Display the items one screen below the items on screen

PAGE UP

Go to the item at the top of the screen in Table view

PAGE UP

Select the first address card on the current page

PAGE UP

Move to the beginning of a multi-line field

PAGE UP

Display the items one screen above the items on screen

PAGE UP or PAGE DOWN
PLUS or MINUS SIGN on the numeric
keypad

Scroll toward the beginning or end of a Help topic in large increments
Expand/collapse a group (with a group selected)

PRINT SCREEN

Copy a picture of the screen to the Clipboard

RIGHT ARROW

Select the first item on screen in an expanded group or the first item off screen to the right

RIGHT ARROW

Go to the next day

RIGHT ARROW

Select the closest address card in the next column

RIGHT ARROW

Move to the next character in a field

RIGHT ARROW

Select the next item

RIGHT ARROW

Move forward in increments of time that are the same as those shown on the time scale. when a unit of
time on the time scale for days is selected

SHIFT+DOWN ARROW

When a menu is selected. display the list of commands

SHIFT+DOWN ARROW

Extend the selection to the next address card and unselect address cards before the starting point

SHIFT+END

Select from the insertion point to the end of the entry

SHIFT+END

Extend the selection to the last address card in the list

SHIFT+ENTER

Move to the previous field without leaving the active card

SHIFT+F1

Display ScreenTip for the active element

SHIFT+F10

Display a shortcut menu

SHIFT+F3

Switch case (with text selected)

SHIFT+F4

Find next during text search

SHIFT+F6

Move to a pane from another pane in the program window (counterclockwise direction)

SHIFT+HOME

Select from the insertion point to the beginning of the entry

SHIFT+HOME

Extend the selection to the first address card in the list

SHIFT+LEFT ARROW

Select or unselect one character to the left

SHIFT+LEFT ARROW or SHIFT+RIGHT Select several adjacent items
ARROW
SHIFT+left mouse button
SHIFT+LEFT. RIGHT. UP. or DOWN
ARROW. or SHIFT+HOM
SHIFT+PAGE DOWN

Specify a Web browser
Change the duration of the selected block of time
Extend the selection to the last address card on the last page
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SHIFT+PAGE UP
SHIFT+RIGHT ARROW

Extend the selection to the first address card on the previous page
Select or unselect one character to the right

SHIFT+TAB

Select the previous hidden text. hyperlink. Show All. or Hide All

SHIFT+TAB

Select the previous hidden text or hyperlink. or the Browser View button at the top of a Microsoft Office
Web site article.

SHIFT+TAB

Move to the previous option or option group in a dialog box

SHIFT+TAB

Select the previous appointment

SHIFT+TAB

Move to the previous field and. from the first field of a card. move to the last field in the previous card

SHIFT+TAB

When the lower time scale is selected. select the upper time scale

SHIFT+UP ARROW

Extend the selection to the previous address card and unselect address cards after the starting point

SHIFT+UP ARROW or DOWN ARROW Extend or reduce the selected time in Day view
SHIFT+UP ARROW or SHIFT+DOWN
ARROW

Extend or reduce the selected items by one item in Table view

SPACEBAR

Perform the action assigned to the selected button in a dialog box. check or clear the selected check
box in a dialog box

TAB

Select Show All or Hide All at the top of a topic. the next hidden text or hyperlink. or the Browser View
button at the top of a Microsoft Office Web site article.

TAB

Select the next hidden text or hyperlink. or Show All or Hide All at the top of a topic

TAB

Move to the next option or option group in a dialog box

TAB

Move between options or areas in the dialog box

TAB

Move to the next field and. from the last field of a card. move to the first field in the next card

TAB

When the upper time scale is selected. select the lower time scale

TAB

When the lower time scale is selected. select the first item on screen or the first group on screen if
items are grouped

TAB or SHIFT+TAB

When a toolbar (toolbar: A bar with buttons and options that you use to carry out commands. To
display a toolbar. use the Customize dialog box (point to Toolbars on the View menu and click
Customize). To see more buttons. click Toolbar Options at the end of the toolbar.) is selected. select
the next or previous button or menu on the toolbar.

To use the following keys. make sure a n/a
card is sel
To use the following keys. make sure a n/a
field in a
Type one or more letters of the name the Select a specific card in the list
card is f
UP ARROW

Select the previous book or Help topic

UP ARROW

Select the previous group

UP ARROW

Select the previous block of time in Day view

UP ARROW

Select the previous address card

UP ARROW

Move to the previous line in a multi-line field

UP ARROW or DOWN ARROW
Use the Ask a Question box

Scroll toward the beginning or end of a Help topic
Press F10 or ALT to select the menu bar. and then press TAB until the insertion point appears in the
Ask a Question box. Type your question. and then press ENTER. To select a topic. use the UP or
DOWN arrow keys. and then press ENTER to open the topic in the Help window. To select the next or
previous set of topics in the Microsoft Office Assistant balloon. select See more or See previous. and
then press ENTER.

Use the Contents. Answer Wizard. and Press F6 to switch from the Help topic to the Contents. Answer Wizard. Index pane (pane: A portion of
Index panes
the document window bounded by and separated from other portions by vertical or horizontal bars. ).
Use the Help topic pane

Press F6 to switch from the Contents. Answer Wizard. Index pane (pane: A portion of the document
window bounded by and separated from other portions by vertical or horizontal bars. ) to the open Help
topic.

Use the Open. Save As. and Insert File The Open. Save As. and Insert File dialog boxes support standard dialog box keyboard shortcuts. (To
dialog boxe
view standard shortcuts for dialog boxes. refer to the Use dialog boxes and Use edit boxes within
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dialog boxes sections in this topic.) These dialog boxes also support the shortcuts below.
With the cursor in the appointment.
ALT+SHIFT+UP A

Change an appointment start or end time

With the cursor in the appointment.
ALT+UP ARROW o

Move an appointment

Visit http://www.shortcutmania.com/ for more printable keyboard shortcuts

